Application Note

Charge-Sharing Driving Circuits for C2000 ADCs (using PSPICE-FOR-TI simulation tool)

James Kennedy and Devin Cottier

ABSTRACT

Microcontrollers from the TMS320F2837xD, TMS320F2837xS, TMS320F2838xD, TMS320F2838xS, TMS320F2807x, TMS320F28004x, TMS320F28002x, TMS320F28003x, TMS320F280013x, and TMS320F280015x series feature high-speed multiplexed analog-to-digital converters (ADCs). These multiplexed data converters provide a good match for real-time control applications that need to sense many control signals with low latency. Under conditions where the sample rate on a given ADC channel is much slower than the total maximum ADC sample rate it may be possible to use a “charge-sharing” input design to drive the ADC input channel. This input design methodology can result in potentially lower cost, simplified circuit designs, and lower acquisition latency when compared to high-speed op-amp based input designs. This application report discusses the conditions where a charge-sharing signal conditioning circuit design is appropriate as well as presents methods to evaluate the circuit’s performance.

Project collateral and source code discussed in this application report can be downloaded from the following URL: http://www.ti.com/lit/zip/spracz0. This application report uses the PSpice for TI design and simulation tool. Charge-Sharing Driving Circuits for C2000 ADCs (TINA-TI) covers the same content but uses the TINA-TI SPICE-based analog simulation program instead.

Table of Contents

1 Introduction .......................................................................................................................... 3
  1.1 Resources....................................................................................................................... 3

2 Charge-Sharing Concept .................................................................................................... 7
  2.1 Traditional High-Speed ADC Driving Circuits.............................................................. 7
  2.2 Increased C_e in High-Speed ADC Driving Circuits...................................................... 7
  2.3 Very Large C_e in ADC Driving Circuits........................................................................ 8
  2.4 Charge-Sharing Operation ............................................................................................ 9
  2.5 Sample Rate and Source Impedance vs. Tracking Error ............................................ 10
  2.6 Analytical Solution to Tracking Error ......................................................................... 12
  2.7 Charge-Sharing in Multiplexed ADCs ......................................................................... 13
  2.8 Charge-Sharing Circuit Advantages .......................................................................... 13
  2.9 Charge-Sharing Circuit Disadvantages ...................................................................... 13

3 Charge Sharing Design Flow ............................................................................................. 14
  3.1 Gather Required Information ...................................................................................... 14
  3.2 Size C_e ......................................................................................................................... 14
  3.3 Verify Sample Rate, Source Impedance, and Bandwidth ........................................... 15
  3.4 Simulate Circuit Setting Performance ....................................................................... 15
  3.5 Input Design Worksheet .............................................................................................. 16

4 Charge-Sharing Circuit Simulation Methods .................................................................. 17
  4.1 Simulation Components ............................................................................................... 17
  4.2 Configure the Simulation Parameters ......................................................................... 19
  4.3 Bias Point Analysis to Determine \( V_{oa_{ss}} \) .................................................................. 21
  4.4 Transient Analysis to Determine \( V_{oa_{ss}} \) ................................................................. 24
  4.5 Measure the Setting Error ........................................................................................... 26
  4.6 Sweeping Source Resistance ...................................................................................... 28

5 Example Circuit Designs ................................................................................................ 30
  5.1 Example 1: Determining Maximum Sample Rate ....................................................... 30
  5.2 Example 2: Adding an Op-amp .................................................................................. 32
5.3 Example 3: Reduced Settling Target................................................................. 37
5.4 Example 4: Voltage Divider............................................................................. 40
6 Summary........................................................................................................... 43
A Appendix: ADC Input Settling Motivation...................................................... 44
  A.1 Mechanism of ADC Input Settling............................................................... 44
  A.2 Symptoms of Inadequate Settling................................................................. 44
References .......................................................................................................... 47
Revision History ................................................................................................ 47

List of Figures

Figure 2-1. High Speed ADC Driving Circuit................................................. 7
Figure 2-2. Charge-Sharing ADC Driving Circuit.......................................... 9
Figure 2-3. ADC Input Circuit With 1 kΩ R and 100 kHz Sample Rate............ 10
Figure 2-4. Simulation Results for 1kΩ R and 100 kHz Sample Rate.............. 10
Figure 2-5. Simulation Results for 100Ω R and 100 kHz Sample Rate............. 11
Figure 2-6. Simulation Results for 1kΩ R and 10kHz Sample Rate............... 11
Figure 2-7. Charge Sharing Steady State With DC Input............................... 12
Figure 4-1. Simulation Schematic (No Op-Amp)............................................ 17
Figure 4-2. Simulation Schematic................................................................. 18
Figure 4-3. Example Timings for \( t_{acq} \) (Piecewise Linear)......................... 19
Figure 4-4. Example Timings for \( t_{bs} \) (Piecewise Linear)................................. 20
Figure 4-5. Bias Point Analysis Simulation Profile........................................ 21
Figure 4-6. Bias Point Analysis Results.......................................................... 22
Figure 4-7. Nodal Analysis Example............................................................... 23
Figure 4-8. Transient Analysis Circuit............................................................. 24
Figure 4-9. Transient Analysis Simulation Profile......................................... 24
Figure 4-10. Transient Analysis Results.......................................................... 25
Figure 4-11. Nodal Analysis Example.............................................................. 26
Figure 4-12. Settling Error Simulation Profile............................................... 26
Figure 4-13. Settling Error Measurement......................................................... 27
Figure 4-14. Settling Error Component Measurement..................................... 28
Figure 4-15. Transient Analysis Simulation Profile General Settings............. 28
Figure 4-16. Transient Analysis Simulation Profile Parametric Sweep.......... 29
Figure 4-17. Source Impedance Sweep Results............................................. 29
Figure 5-1. Example 1: Simulation Circuit...................................................... 30
Figure 5-2. Example 1: Simulation Profile....................................................... 31
Figure 5-3. Example 1: Simulation Results...................................................... 31
Figure 5-4. Example 2: Simulation Circuit...................................................... 33
Figure 5-5. Example 2: Simulation Profile....................................................... 34
Figure 5-6. Example 2: Simulation Results...................................................... 34
Figure 5-7. Example 2: Stability Simulation Circuit....................................... 35
Figure 5-8. Example 2: Stability Simulation Profile........................................ 35
Figure 5-9. Example 2: Stability Simulation Results....................................... 36
Figure 5-10. Example 3: Simulation Circuit.................................................... 38
Figure 5-11. Example 3: Simulation Profile..................................................... 38
Figure 5-12. Example 3: Simulation Results.................................................... 38
Figure 5-13. Example 4: Simulation Circuit.................................................... 41
Figure 5-14. Example 4: Simulation Profile..................................................... 41
Figure 5-15. Example 4: Simulation Results.................................................... 42
Figure A-1. Setting of the ADC S+H Capacitor........................................... 44
Figure A-2. Sequence of Samples With \( C_H \) Retained Between Conversions 45
Figure A-3. Sequence of Samples With \( C_H \) Discharged Between Conversions 45
Figure A-4. Sequence of Multiplexed Samples.......................................... 46

List of Tables

Table 1-1. Series of Devices.................................................................................. 5
Table 2-1. Settling Time With Increasing \( C_H \) in High-Speed ADC Driver........ 8
Table 2-2. Settling Time Under Charge-Sharing Conditions............................ 8
Table 3-1. ADC Charge Sharing Design Worksheet........................................ 16
Table 5-1. Example 1: ADC Charge Sharing Design Worksheet..................... 32
Table 5-2. Example 2: ADC Charge Sharing Design Worksheet..................... 36
Table 5-3. Example 3: ADC Charge Sharing Design Worksheet..................... 39
1 Introduction

When driving an ADC input, achieving good settling performance is critical. Failing to achieve the necessary settling performance in the ADC driving circuits can result in distortion and memory cross-talk in the ADC conversion results. For an in-depth discussion of the importance of minimizing errors associated with ADC input settling, see Appendix A. The signal conditioning circuits used to drive an ADC channel can vary widely in their requirements and implementation depending on the application requirements for that particular channel as well as the ADC input and sampling characteristics.

When sampling a high bandwidth signal near the maximum sample rate in a high-speed ADC, a very high performance driving circuit is required. This typically is comprised of a high-speed and low-noise op-amp stage that has passive component values optimized for minimal settling time (low resistor and capacitor values). These high performance drive stage circuits are suitable for driving most input signals, but require a high bandwidth op-amp which can have high component cost and may consume substantial printed circuit board area. Furthermore, if significant low-pass filtering is desired (many times desirable to limit noise in the conversion results), an additional active op-amp based filter stage may be necessary, adding cost and area.

Under certain circumstances, signals with sufficiently low sample rate can be directly interfaced to an ADC input channel by using a large "charge-sharing" capacitor placed on the ADC input. This method has the advantage of being simple, low-cost, and provides low-pass filtering. Furthermore, this can sometimes reduce sampling latency associated with the ADC acquisition. In particular, real-time control applications tend to use the ADC to scan through multiple multiplexed channels in a burst of conversions. These periodic bursts result in a sample rate on each channel that can be much less than the maximum sample rate of the ADC, which can sometimes achieve the necessary conditions for a charge-sharing input design.

This application report explains the mechanism that charge-sharing inputs use to achieve fast settling and will provide methods for designing a charge-sharing ADC driving circuit. Simulation methods will also be provided for verifying proper circuit settling behavior.

1.1 Resources

The following tools and materials are useful for ADC driver circuit design and evaluation for input settling.

1.1.1 TINA-TI SPICE-Based Analog Simulation Program

TI provides the TINA-TI application to TI customers to allow easy SPICE-based simulation of circuits utilizing TI products. Because this application report uses PSpice for TI instead of TINA-TI to evaluate circuit settling performance, it is not necessary to ensure TINA-TI is downloaded and installed before proceeding. However, the TINA-TI application and additional resources are still made available.

Link to Tool Folder: TINA-TI™

1.1.2 PSpice for TI Design and Simulation Tool

TI provides the PSpice for TI application to TI customers to allow easy SPICE-based simulation of circuits utilizing TI products. This application report utilizes this program to evaluate circuit settling performance. Ensure this application is downloaded and installed before proceeding.

Link to Tool Folder: PSpice® for TI

Link to PSpice for TI Training Series: Explore PSpice for TI

Link to TI E2E Support Forum: Welcome to TI E2E Design Support Forums

Link to Cadence PSpice for TI Forum: Welcome to PSpice Forum
1.1.3 Application Report: ADC Input Circuit Evaluation for C2000 MCUs

This application report describes how to design and evaluate high-speed op-amp based ADC input driving circuits for C2000 real-time MCU ADCs. Review this application report before proceeding to understand high-speed op-amp based ADC input circuit design methods.

Link to application report: ADC Input Circuit Evaluation for C2000 MCUs

1.1.4 TI Precision Labs - SAR ADC Input Driver Design Series

TI Precision Labs has provided an excellent eight-part video series that demonstrates how to design the input drivers for a SAR ADC. Reviewing this material will help to further understand the high-speed op-amp based signal conditioning design process and options.

Link to Video Training Series: TI Precision Labs - SAR ADC Input Driver Design

1.1.5 Analog Engineer's Calculator

The analog engineer's calculator tool provides a variety of very useful GUI-based calculation tabs to assist with common analog circuit design tasks. The high-speed op-amp design methodology takes advantage of the Data Converters ➔ ADC SAR Drive calculator.

Link to Tool Folder: Analog Engineer's Calculator

1.1.6 TI Precision Labs - Op Amps: Stability Series

TI Precision Labs has provided an excellent seven-part video series on op-amp stability. If charge-sharing input circuits do require an op-amp, the amplifier is usually exposed to a very large capacitive load. It is best practice to simulate to ensure that the source resistor is sufficiently large to ensure op-amp stability.

Link to Video Training Series: TI Precision Labs - Op amps: Stability

1.1.7 Related Application Reports

TI provides several application reports that pertain to the design and evaluation of ADC input circuits on C2000 real-time MCU devices. These application reports are listed along with brief descriptions.

<table>
<thead>
<tr>
<th>Application Report Title</th>
<th>Schematic Capture and Simulation Tool</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC Input Circuit Evaluation for C2000 MCUs (TINA-TI)</td>
<td>TINA-TI</td>
<td>Describes how to design and evaluate a traditional high-speed ADC driving circuit. Input circuit includes an op-amp. Appropriate when sampling a high bandwidth signal near the maximum sample rate of the ADC.</td>
</tr>
<tr>
<td>ADC Input Circuit Evaluation for C2000 MCUs (PSpice for TI)</td>
<td>PSpice for TI</td>
<td>Describes how to design and evaluate a charge-sharing ADC driving circuit. Input circuit may or may not include an op-amp. Appropriate when sampling a signal with a sufficiently low bandwidth and sample rate.</td>
</tr>
<tr>
<td>Charge-Sharing Driving Circuits for C2000 ADCs (TINA-TI)</td>
<td>TINA-TI</td>
<td>Describes strategies to mitigate memory cross-talk error when the input circuit design does not achieve adequate settling. Applicable under special circumstances.</td>
</tr>
</tbody>
</table>
1.1.8 Comparison of Schematic Capture and Simulation Tools

This application report uses the PSpice for TI design and simulation tool. However, TI also offers the TINA-TI SPICE-based analog simulation program. Both PSpice for TI and TINA-TI are capable of performing bias point, transient, AC sweep, DC sweep, and Fourier analyses. While both PSpice for TI and TINA-TI can sweep temperatures and component values, only PSpice for TI can sweep global parameters. Furthermore, only PSpice for TI includes features such as multiple simulation profiles and the Performance Analysis tool. Customers that use PSpice for TI can also access the most up-to-date simulation models of TI devices within PSpice for TI using the PSpice Part Search tool while customers that use TINA-TI must download these models from https://www.ti.com/. Ultimately, PSpice for TI is the more complex, powerful, and feature-rich schematic capture and simulation tool.

Both PSpice for TI and TINA-TI are made available to TI customers for free. Moreover, TI supports both PSpice for TI and TINA-TI by supplying simulation models of TI devices, answering questions on the E2E support forums, and providing additional collateral such as application reports and training resources.

1.1.9 PSpice for TI ADC Input Models

This application report is bundled with pre-generated ADC input models for several families of devices. The families of devices are listed alongside the ADC input models associated with each family and a brief description of each ADC input model.

For C2000 devices that are not listed in the table below, the input models below can still be used as long as the signal mode matches (use a single-ended model for single-ended ADC operation or use a differential model for differential ADC operation). The $R_{on}$ and $C_h$ values also need to be updated to match the values specified in the device-specific data manual.

<table>
<thead>
<tr>
<th>Series of Devices</th>
<th>ADC Input Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS320F2807x</td>
<td>F2807x_Ext</td>
<td>F2807x ADC input model External reference of 3.0 V 12-bit resolution Single-ended input mode</td>
</tr>
<tr>
<td>TMS320F2837xD, TMS320F2837xS</td>
<td>F2837x_Ext_12BSE</td>
<td>F2837x ADC input model External reference of 3.0 V 12-bit resolution Single-ended input mode</td>
</tr>
<tr>
<td>TMS320F2838xD, TMS320F2838xS</td>
<td>F2838x_Ext_12BSE</td>
<td>F2838x ADC input model External reference of 3.0 V 12-bit resolution Single-ended input mode</td>
</tr>
<tr>
<td></td>
<td>F2838x_Ext_16BSE</td>
<td>F2838x ADC input model External reference of 3.0 V 16-bit resolution Single-ended input mode</td>
</tr>
<tr>
<td>TMS320F28002x</td>
<td>F28002x_Ext</td>
<td>F28002x ADC input model External reference of 3.0 V 12-bit resolution Single-ended input mode</td>
</tr>
<tr>
<td></td>
<td>F28002x_Int25</td>
<td>F28002x ADC input model External reference of 2.5 V 12-bit resolution Single-ended input mode</td>
</tr>
<tr>
<td></td>
<td>F28002x_Int33</td>
<td>F28002x ADC input model External reference of 3.3 V 12-bit resolution Single-ended input mode</td>
</tr>
</tbody>
</table>
### Table 1-1. Series of Devices (continued)

<table>
<thead>
<tr>
<th>Series of Devices</th>
<th>ADC Input Model</th>
<th>Description</th>
</tr>
</thead>
</table>
| TMS320F28004x     | F28004x_Ext     | F28004x ADC input model  
|                   |                 | External reference of 3.0 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F28004x_Int25   | F28004x ADC input model  
|                   |                 | Internal reference of 2.5 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F28004x_Int33   | F28004x ADC input model  
|                   |                 | Internal reference of 3.3 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
| TMS320F28003x     | F28003x_Ext     | F28003x ADC input model  
|                   |                 | External reference of 3.0 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F28003x_Int25   | F28003x ADC input model  
|                   |                 | Internal reference of 2.5 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F28003x_Int33   | F28003x ADC input model  
|                   |                 | Internal reference of 3.3 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
| TMS320F280013x    | F280013x_Ext    | F280013x ADC input model  
|                   |                 | External reference of 3.0 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F280013x_Int25  | F280013x ADC input model  
|                   |                 | Internal reference of 2.5 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F280013x_Int33  | F280013x ADC input model  
|                   |                 | Internal reference of 3.3 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
| TMS320F280015x    | F280015x_Ext    | F280015x ADC input model  
|                   |                 | External reference of 3.0 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F280015x_Int25  | F280015x ADC input model  
|                   |                 | Internal reference of 2.5 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |
|                   | F280015x_Int33  | F280015x ADC input model  
|                   |                 | Internal reference of 3.3 V  
|                   |                 | 12-bit resolution  
|                   |                 | Single-ended input mode  |

**CAUTION**

While the ADC input models for multiple C2000 devices are bundled with this application report, input model component values should always first be verified with the device-specific data manual before proceeding. For more information, see Section 4.1.5.
2 Charge-Sharing Concept

The following sections describe the conceptual operation of charge-sharing input circuits.

2.1 Traditional High-Speed ADC Driving Circuits

In a traditional ADC input driving circuit as shown in Figure 2-1, the circuit is designed to generally minimize the overall circuit time constant (within some minor constraints), including the external source resistance \((R_s)\) and external source capacitance \((C_s)\). A high bandwidth op-amp is also generally needed to take advantage of this fast time constant. In the end, this circuit is capable of quickly settling the value on \(C_H\) during the allotted S+H (sample-and-hold) window even when the ADC is sampling at high speed. The input signal being sampled can also have very high bandwidth.

For more information on design of op-amp based high-speed ADC signal conditioning circuits, see the TI Precision Labs video series: TI Precision Labs - SAR ADC Input Driver Design as well as the C2000 specific application report ADC Input Circuit Evaluation for C2000 MCUs.

![Figure 2-1. High Speed ADC Driving Circuit](image)

2.2 Increased \(C_s\) in High-Speed ADC Driving Circuits

To implement a charge-sharing input design, \(C_s\) will be made very large. Care must be taken, however, because a large \(C_s\) is detrimental in a typical high-speed ADC driving circuit. The need to keep \(R_s\) and \(C_s\) small in the high speed ADC driving circuit can be understood by looking at the equation for the approximate time constant and settling time given by the equations below.

An approximation of the required settling time can be determined using an RC settling model. The time constant for the model is given by the equation:

\[
\tau = (R_s + Ron) \cdot C_H + R_s \cdot (C_s + C_P)
\]  

And the number of time constants needed is given by the equation:

\[
k = \ln \left( \frac{1}{n \text{settling error}} \right) - \ln \left( \frac{C_s + C_P}{C_H} \right)
\]  

So the total S+H time should be set to approximately:

\[
t = k \cdot \tau
\]

Where the following parameters are provided by the ADC input model in the device-specific data manual:

- \(n\) = ADC resolution (in bits)
- \(R_{ON}\) = ADC sampling switch resistance (in Ohms)
- \(C_H\) = ADC sampling capacitor (in pF)
- \(C_P\) = ADC channel parasitic input capacitance (in pF)
And the following parameters are dependent on the application design:

- settling error = tolerable settling error (in LSBs)
- \( R_s \) = ADC driving circuit source impedance (in Ohms)
- \( C_S \) = capacitance on ADC input pin (in pF)

From the above equations, it is clear that increasing \( R_s \) will result in strictly longer settling time because \( R_s \) is present in both terms of \( \tau \) and has no effect on \( k \). On the other hand, increasing \( C_S \) will increase \( \tau \) but simultaneously reduce \( k \) due to increasing the ratio of \( C_S \) to \( C_H \) in the second term in \( k \). However, increased \( C_S \) will result in longer settling time as the examples in Table 2-1 demonstrate. This is because the time constant, \( \tau \), increases linearly while the number of time constants needed, \( k \), decreases logarithmically. Therefore, high-speed ADC driving circuit designs generally keep the magnitude of \( C_S \) small (typically 20 times \( C_H \)) because increasing \( C_S \) results in additional settling time.

### Table 2-1. Settling Time With Increasing \( C_S \) in High-Speed ADC Driver

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Example 1</th>
<th>Example 2</th>
<th>Example 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>( C_S )</td>
<td>220 pF</td>
<td>1 nF</td>
<td>2.2 nF</td>
</tr>
<tr>
<td>( C_H )</td>
<td>12.5 pF</td>
<td>12.5 pF</td>
<td>12.5 pF</td>
</tr>
<tr>
<td>( C_P )</td>
<td>10 pF</td>
<td>10 pF</td>
<td>10 pF</td>
</tr>
<tr>
<td>( R_s )</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>( R_{ON} )</td>
<td>425Ω</td>
<td>425Ω</td>
<td>425Ω</td>
</tr>
<tr>
<td>( n )</td>
<td>12 bits</td>
<td>12 bits</td>
<td>12 bits</td>
</tr>
<tr>
<td>Settling error</td>
<td>0.5 LSBs</td>
<td>0.5 LSBs</td>
<td>0.5 LSBs</td>
</tr>
<tr>
<td>( \tau )</td>
<td>17.4 ns</td>
<td>56.4 ns</td>
<td>116.4 ns</td>
</tr>
<tr>
<td>( k )</td>
<td>6.1</td>
<td>4.6</td>
<td>3.8</td>
</tr>
<tr>
<td>Settling time</td>
<td>106.1 ns</td>
<td>259.4 ns</td>
<td>442.3 ns</td>
</tr>
</tbody>
</table>

### 2.3 Very Large \( C_S \) in ADC Driving Circuits

While the previous section showed that increasing \( C_S \) results in increased settling time, there is one exception: if \( C_S \) is made sufficiently large that the second term of the equation for \( k \) (reproduced below) becomes equal to (or greater) than the first term, \( k \) will become zero (or negative) and thus the settling time, given by \( k \cdot \tau \), will become zero (or negative) regardless of the size of \( \tau \). Because the predicted settling time is effectively zero, the minimum S+H duration specified in the ADC data manual can be used! When this condition is used in the design of the ADC driving circuit, the circuit is said to be using "charge-sharing".

\[
k = \ln\left(\frac{2^n}{\text{settling error}}\right) - \ln\left(\frac{C_S + C_P}{C_H}\right)
\]

Table 2-2 shows an example of evaluating the equations under charge-sharing conditions.

### Table 2-2. Settling Time Under Charge-Sharing Conditions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Charge Sharing Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>( C_S )</td>
<td>102.4 nF</td>
</tr>
<tr>
<td>( C_H )</td>
<td>12.5 pF</td>
</tr>
<tr>
<td>( C_P )</td>
<td>10 pF</td>
</tr>
<tr>
<td>( R_s )</td>
<td>50</td>
</tr>
<tr>
<td>( R_{ON} )</td>
<td>425Ω</td>
</tr>
<tr>
<td>( n )</td>
<td>12 bits</td>
</tr>
<tr>
<td>settling error</td>
<td>0.5 LSBs</td>
</tr>
<tr>
<td>( \tau )</td>
<td>5.1 ( \mu )s</td>
</tr>
<tr>
<td>( k )</td>
<td>0.0</td>
</tr>
<tr>
<td>Settling time</td>
<td>0.0 ns</td>
</tr>
</tbody>
</table>
Conceptually, the second term in the equation for \( k \) is compensating for the driver not needing to fully charge both \( C_s \) and \( C_H \). Instead, \( C_s \) is assumed to be pre-charged to the applied source voltage. This pre-charging occurs during the time when the ADC is converting and the S+H is inactive. When the S+H switch closes, the charge on \( C_s \) and \( C_H \) will equalize. At the same time, the source will exponentially settle both \( C_s \) and \( C_H \) towards the applied voltage. The larger \( C_s \) is, the closer the voltage between \( C_s \) and \( C_H \) will be to the source voltage after equalization. In the charge-sharing case, \( C_s \) is made so large that equalization alone is sufficient to get \( C_H \) to within the settling error target.

**CAUTION**
For either high speed op-amp based design or charge-sharing based designs, sometimes simulation or analysis predicts that a S+H duration less than the minimum duration in the device-specific data manual allows for sufficient settling performance. Even in these cases, always select a S+H duration that meets the device-specific data manual minimum specified S+H duration.

### 2.4 Charge-Sharing Operation

Figure 2-2 demonstrates a typical charge-sharing input circuit design as well as the conceptual settling operation sample-to-sample. \( C_s \) is set to a very large value. Specifically in this case, \( C_s \) is set to 100 nF, which is roughly \( 2^{12+11} \) times as large as the internal ADC S+H capacitor, \( C_H \). This ensures that the drop in charge on \( C_s \) when sampling is only 0.5 LSBs at 12-bit ADC resolution.

The right sub-plot of Figure 2-2 shows the conceptual settling operation for this charge-sharing input design. At the beginning of each sample, the charge between \( C_s \) and \( C_H \) quickly equalizes, causing \( C_s \) to drop less than 0.5 LSBs and \( C_H \) to charge to within 0.5 LSBs of the applied voltage. This ensures that \( C_H \) reaches the settling target even when the S+H duration is very short. In the time between samples \( C_s \) is recharged from the source voltage through \( R_s \). This example assumes the ADC is sampling slow enough that \( C_s \) can be almost completely recharged between samples. The next section explores how feasible this assumption is.

![Figure 2-2. Charge-Sharing ADC Driving Circuit](image)

**Note**
Figure 2-2 shows a 500 Ω source resistance, \( R_s \). While high speed op-amp based signal conditioning circuits usually determine and place this value intentionally, charge sharing designs are many times used to work around an existing source impedance without resorting to adding an additional op-amp to the design. This source resistance could be the output impedance of a sensor or the equivalent resistance of a voltage divider used to sense a high voltage bus. If the \( R_s \) is intentionally placed in a charge-sharing input circuit design, it is usually done so to form a low-pass filter with \( C_s \).
2.5 Sample Rate and Source Impedance vs. Tracking Error

Designers of high speed op-amp based ADC signal conditioning circuits are required to trade-off settling speed against op-amp bandwidth and external component sizes. Meeting the charge-sharing criterion for source capacitor size ensures that the minimum ADC S+H window duration can be used regardless of source impedance. However, this creates a new trade-off that needs to be optimized: sample rate and source impedance vs. tracking error.

Significant tracking error occurs when the ADC samples too fast relative to the source’s ability to recharge \( C_s \) through \( R_s \) in the time between samples. This is illustrated by simulating the circuit shown in Figure 2-3. The results from this simulation can be seen in Figure 2-4: each step down in the sawtooth waveform is a charge equalization due to ADC sampling. In this situation, the first sample causes the voltage on the pin to drop by about 0.5 LSBs, resulting in a good sample of the DC input voltage. However, the external source is only able to partially recharge \( C_s \) before the next sample occurs. Each sample subsequently bleeds off some of the charge on \( C_s \). Eventually, an equilibrium is reached when the delta between the pin voltage and the source voltage increases enough to drive 0.5 LSBs of recovery in the time between samples. In the simulation results of Figure 2-4, the equilibrium is reached at about 3.6 mV of tracking error.

![Figure 2-3. ADC Input Circuit With 1 kΩ \( R_s \) and 100 kHz Sample Rate](image1)

![Figure 2-4. Simulation Results for 1kΩ \( R_s \) and 100 kHz Sample Rate](image2)
The settling error target is usually set to 0.5 LSBs, but applications may be able to tolerate more or less settling error. If a 1 LSB settling error target is assumed, the previous example circuit is still far out of target range with 0.5 LSBs of charge-share error plus 3.6 mV of tracking error (about 5 LSBs). To get the tracking error within tolerance, either the sample rate needs to be reduced or the source impedance, $R_s$, needs to be reduced (or both).

Figure 2-5 and Figure 2-6 show that by significantly reducing the source impedance or the sample rate the tracking error can be made to be of a similar magnitude to the error from charge equalization, resulting in an overall settling error within the target of 1 LSBs.
Note

The example above shows a DC source voltage with a S+H capacitor that always starts fully discharged to 0 V. This makes the resulting tracking error look like the ADC input pin is drooping to a lower voltage. In the case of an AC input signal the voltage on the pin will lag behind the applied voltage. In the case the S+H capacitor starts at a voltage other than 0 V (likely in multiplexed ADCs) the pin voltage will be pulled towards that other voltage (possibly the previously sampled channel in the mux sampling sequence).

2.6 Analytical Solution to Tracking Error

In a charge-sharing design, the total settling error is made up of two error components: the charge-sharing error and the tracking error. The charge-sharing error is determined by the relative sizes of the source capacitance, $C_s$, and the ADC's internal S+H capacitance, $C_H$. The tracking error is determined by the ability of the source to recharge $C_s$ through the external source resistance, $R_s$, in the time between samples. Since the recharge primarily occurs while the ADC sampling switch is open, a first-order exponential RC settling model is appropriate where the RC time constant, $\tau$, is determined by $R_s$ and $C_s$.

To simplify analysis, it is assumed that the total settling error budget is equally divided between charge-sharing error and tracking error. In the case of a total settling error budget of 0.5 LSBs, the target for each of the sub-components would be 0.25 LSBs. Regardless of the absolute magnitude of the error components, allowing 50% recovery in the time between samples results in equal error component magnitudes (equivalent to approximately 0.7 RC time constants). The equal error magnitudes in equilibrium are illustrated in Figure 2-7. At the beginning of each sample, charge equalizes between $C_s$ and $C_H$, resulting in a 0.25 LSBs drop in voltage. Then, in the time until the next conversion, the pin voltage charges exponentially back towards the applied DC voltage. Recovering from 0.5 LSBs to 0.25 LSBs requires 50% settling.

\[
\text{Total Settling Error (± 0.5 LSB)} = V_{pin} + \text{Charge-Share Error (± 0.25 LSB)} + \text{Tracking Error (± 0.25 LSB)}
\]

\[\text{Time between samples}\]

\[\text{Applied DC Voltage}\]

\[\text{50\% recovery} = 0.7\tau\]

\[\text{Figure 2-7. Charge Sharing Steady State With DC Input}\]

Since the criteria for equal error components requires 0.7 time constants, the following equation determines the approximate maximum sample rate given a fixed source impedance:

\[f_s \leq \frac{1}{0.7 \cdot R_s C_s}\]  \hspace{1cm} (5)

Alternately, if a specific sample rate is required, the above equation can be rearranged to give the maximum source impedance for a known sample rate:

\[R_s \leq \frac{1}{0.7 f_s C_s}\]  \hspace{1cm} (6)
For example, consider a circuit with 12.5 pF $C_H$, target sample rate of 10 ksp, and settling error target of 0.5 LSBs at 12-bit resolution. To get charge sharing error of 0.25 LSBs, $C_s$ will be set to approximately 12.5 pF-$\left(\frac{4096}{0.25}\right) = 204.8$ nF. This will then yield a maximum source impedance of:

$$R_s \leq \frac{1}{(0.7\times10\text{kHz}\times204.8\text{nF})}$$

$$R_s \leq 698\ \Omega$$

Note

In the case that the maximum sample rate does not meet the application requirements, an op-amp can be added to isolate the existing source resistance from the circuit. $R_s$ should then be selected to be large enough to ensure the op-amp is stable when driving $C_s$. This op-amp should also have a bandwidth of at least 4 times that of the RC time constant formed from $R_s$ and $C_s$.

2.7 Charge-Sharing in Multiplexed ADCs

Multiplexed ADCs connect many analog input channels to a single ADC. The ADC can then scan through the multiple input channels either continuously or in bursts based on an external trigger (many times an ePWM trigger in C2000 applications).

For the sake of charge-sharing, the sample rate on a given channel is important, not the full sample rate of the ADC. This is because charge-sharing equalization will only occur when the particular multiplexed channel is sampled and the source capacitance will have the entire time between sampling to recharge, even if other channels are sampled in the meantime. In applications where the ePWM is triggering the ADC periodically, the sample rate on a given multiplexed channel will match the ePWM triggering frequency.

2.8 Charge-Sharing Circuit Advantages

The previous sections describe how a charge sharing circuit can be constructed as an alternative to high-speed op-amp based ADC driving circuits. This can be done for a variety of reasons:

- **Low Latency**
  
  A charge-sharing design can always use the minimum S+H time. If the application goal is to reduce the latency between ADC trigger and ADC sample completion, using a shorter S+H time can be advantageous. Achieving equivalent settling time with a high-speed op-amp based design may require extremely high op-amp bandwidth.

- **Low Cost**
  
  Charge-sharing designs can sometimes entirely eliminate an op-amp channel from the design. If the channel sample rate is slow enough, a charge-sharing design can be used to directly interface to sensors with large output impedance. This also includes directly interfacing to a voltage divider, which will have a large equivalent output impedance in order to minimize static current draw.

- **Low-Pass Filtering**
  
  High-speed op-amp designs generally can not provide significant low-pass filtering (including anti-aliasing filtering) in the drive stage due to the need to keep the R and C component values very low to ensure fast settling. In these designs if significant low-pass filtering is needed, a separate filter stage is built before the ADC drive stage. In contrast, charge-sharing input designs can many times also provide significant low-pass filtering due to the large source capacitor size needed to meet the charge-sharing criterion.

2.9 Charge-Sharing Circuit Disadvantages

Charge-sharing ADC input designs are not appropriate for all signal conditioning requirements. Care should be taken to select a high-speed op-amp based design when it is more appropriate, including:

- **High Speed Sampling**
  
  When sampling at high speed on a single channel, the tracking error in a charge-sharing design will become prohibitively large. In this case, a high-speed op-amp based ADC driver will be needed.
Compatibility With Oversampling Methods
Sampling the same signal multiple times back-to-back and then averaging the results can be a good method to reduce system noise or sampling noise. However, in the case of a charge-sharing ADC driver, these multiple samples will increase the effective sample rate on the channel, increasing the tracking error. In the case the extra samples are back-to-back, the channel sample rate becomes as fast as the ADC sample rate, which will likely create excessive tracking error.

High Bandwidth Signals
The large capacitor needed to meet the charge-sharing criterion will inherently provide some amount of low-pass filtering. For undersampling applications or other applications that require sampling of a high bandwidth signal, charge sharing may not be feasible.

Extremely Low Distortion
C0G and NP0 type capacitors provide very low capacitance vs. voltage nonlinearity. If the ADC signal chain uses these capacitors it is possible to achieve excellent distortion performance. These capacitors are less dense than higher distortion alternatives (for example X7R type). This can make component selection for the very large capacitances needed for charge-sharing designs infeasible, particularly at high resolution (for example 16-bit resolution). For more information, see Selecting capacitors to minimize distortion in audio applications.

3 Charge Sharing Design Flow
The following sections walk through the steps necessary to design a charge-sharing ADC input driver. A worksheet is provided in Section 3 for convenience.

1. Gather circuit information and requirements
2. Size $C_s$
3. Verify sample rate, source impedance, and bandwidth
4. Simulate circuit settling performance

3.1 Gather Required Information
The following information will be needed to proceed with designing and verifying the charge sharing input circuit. As these values are gathered, they can be filled into the worksheet provided in Section 3.5.

- $N$: Target settling resolution (bits). Usually the same as the resolution of the ADC. Lower resolution can be targeted to relax the input design requirements.
- $V_{fs}$: Full scale voltage range. In external reference mode, this is the voltage supplied to the VREFHI pin (usually 3.0 V or 2.5 V).
  In internal reference mode, this is the effective input range based on the selected reference mode (usually 3.3 V or 2.5 V).
- $C_{H}$: ADC S+H capacitance. Provided in the data manual table "Input Model Parameters".
- $C_p$: ADC pin parasitic capacitance. Provided in the data manual table "Per-Channel Parasitic Capacitance".
- $R_s$: Source resistance. Output resistance of source driving ADC. Can also be intentionally selected.
- $F_s$: Sample rate on channel of interest. Usually a requirement from the application.
- $BW_s$: Source signal required bandwidth.

3.2 Size $C_s$
$C_s$ should be sized such that the charge-share error is 0.25 LSBs. The design process will ensure that the tracking error is also within 0.25 LSBs, resulting in a total settling error within 0.5 LSBs. To achieve this, select $C_s$ to be at least as large as the below equation indicates. It will then be necessary to round the results to a standard capacitor component size.

$$C_s = (2^{N+2} \cdot C_H) - C_p$$ (9)

In many designs, the size of $C_p$ compared to the size of the selected $C_s$ will be negligible and thus $C_p$ can be ignored.
3.3 Verify Sample Rate, Source Impedance, and Bandwidth

Once the source capacitor has been sized, several items can be validated in the design. These include:

• **Maximum Sample Rate**

If the source resistance is known the maximum sampling rate that can be supported without exceeding the tracking error budget can be calculated using the equation below.

\[ f_{s_{\text{max}}} = \frac{1}{0.7 \cdot R_s \cdot C_s} \]  \hspace{1cm} (10)

The application required sample rate (on the channel under consideration) \( f_s \) should be less than \( f_{s_{\text{max}}} \).

• **Maximum Source Resistance**

Alternatively, if the application sample rate is fixed, the maximum source impedance that will result in tracking error within the error budget can be calculated using this equation.

\[ R_{s_{\text{max}}} = \frac{1}{0.7 \cdot f_s \cdot C_s} \]  \hspace{1cm} (11)

This can then be checked against the source impedance of one or more input channels that are utilizing a charge-sharing input design to ensure that \( R_s < R_{s_{\text{max}}} \).

• **Bandwidth**

The filter bandwidth of the low-pass filter formed from \( C_s \) and \( R_s \) can be calculated using the following formula.

\[ \text{BW}_{RsCs} = \frac{1}{2\pi \cdot C_s \cdot R_s} \]  \hspace{1cm} (12)

Ensure that the source signal bandwidth, \( \text{BW}_s \), is less than the low-pass filter bandwidth from this step. If the filter bandwidth is too low, frequencies of interest of the input signal will be attenuated.

3.4 Simulate Circuit Settling Performance

The formulas above will target \( N + 1 \) bit settling performance which can further be divided into \( N + 2 \) bits of charge-share error and \( N + 2 \) bits of tracking error. In order to compare these targets to simulation results in volts, the absolute settling error target can be calculated as:

\[ V_{err_{\text{max}}} = V_{fs} / 2^{N+1} \]  \hspace{1cm} (13)

The settling simulation can then be run to verify that the measured settling error is within this error budget. For specifics on how to perform the settling simulation with a charge-sharing circuit, see Section 4.
3.5 Input Design Worksheet

Table 3-1 lists the required inputs needed to evaluate an ADC input driving circuit using the charge-sharing method and provides a place to summarize the outputs. Completing this worksheet for each unique circuit in your real-time control application is recommended to ensure good settling performance. For some circuits, it may be desirable to instead use the high-speed design methodology presented in the application report ADC Input Circuit Evaluation for C2000 MCUs (using PSPICE-for-TI simulation tool). That report also provides a worksheet that can be evaluated using the high-speed design methodology.

### Table 3-1. ADC Charge Sharing Design Worksheet

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Target settling resolution (bits)</td>
<td>Usually the same as the resolution of the ADC. Lower resolution can be targeted to relax the input design requirements.</td>
<td></td>
</tr>
<tr>
<td>$V_{fs}$</td>
<td>Full scale voltage range</td>
<td>In external reference mode, this is the voltage supplied to the VREFHI pin (usually 3.0 V or 2.5 V). In internal reference mode, this is the effective input range based on the selected reference mode (usually 3.3 V or 2.5 V).</td>
<td></td>
</tr>
<tr>
<td>$V_{err\text{max}}$</td>
<td>Maximum error target</td>
<td>$V_{fs}/2^{N+1}$ Can be further divided into two components: charge-sharing error and tracking error, each $V_{err\text{max}}/2$</td>
<td></td>
</tr>
<tr>
<td>$t_{\text{sh}}$</td>
<td>S+H time</td>
<td>As long as $C_s$ is sized appropriately for charge-sharing, the minimum value from the ADC data manual can be used.</td>
<td></td>
</tr>
<tr>
<td>$C_h$</td>
<td>ADC S+H capacitance</td>
<td>Provided in the data manual table &quot;Input Model Parameters&quot;</td>
<td></td>
</tr>
<tr>
<td>$C_p$</td>
<td>ADC pin parasitic capacitance</td>
<td>Provided in the data manual table &quot;Per-Channel Parasitic Capacitance&quot;</td>
<td></td>
</tr>
<tr>
<td>$C_s$</td>
<td>Source capacitance</td>
<td>At least $(2^{N+2}\cdot C_h) - C_p$</td>
<td></td>
</tr>
<tr>
<td>$R_s$</td>
<td>Source resistance</td>
<td>Output resistance of source driving ADC. Can also be intentionally selected.</td>
<td></td>
</tr>
<tr>
<td>$f_s$</td>
<td>Sample Rate</td>
<td>Sample rate on channel of interest. Usually a requirement from the application.</td>
<td></td>
</tr>
<tr>
<td>$BW_s$</td>
<td>Source signal required bandwidth.</td>
<td>Source signal required bandwidth.</td>
<td></td>
</tr>
<tr>
<td>$R_{s\text{max}}$</td>
<td>Max allowable source resistance</td>
<td>If $f_s$ is known, calculate as $1/(0.7\cdot f_s\cdot C_s)$. If the condition is not met, additional design iteration is needed.</td>
<td></td>
</tr>
<tr>
<td>$f_{s\text{max}}$</td>
<td>Max allowable sampling frequency</td>
<td>If $R_s$ is known, calculate as $1/(0.7\cdot R_s\cdot C_s)$. If the condition is not met, additional design iteration is needed.</td>
<td></td>
</tr>
<tr>
<td>$BW_{RsCs}$</td>
<td>Filter bandwidth from $C_s$ and $R_s$</td>
<td>$1/(2\pi\cdot C_s\cdot R_s)$. Ensure that $BW_{RsCs} &gt; BW_s$, otherwise additional design iteration is needed.</td>
<td></td>
</tr>
<tr>
<td>$V_{oa_ss}$</td>
<td>Steady state op-amp output voltage</td>
<td>If no op-amp is used, set $V_{oa_ss} = V_{fs}$, otherwise this can be generated from DC nodal analysis of the $V_{oa}$ node. Copy to $Voa_ss$ before proceeding with other simulations.</td>
<td></td>
</tr>
<tr>
<td>$BWOPA$</td>
<td>ADC driver op-amp minimum bandwidth</td>
<td>If an op-amp is needed, bandwidth should be at least 4 times $BW_{RsCs}$</td>
<td></td>
</tr>
<tr>
<td>Op-amp</td>
<td>Selected Op-amp part number</td>
<td>Record selected op-amp here (if needed).</td>
<td></td>
</tr>
<tr>
<td>$V_{err}$</td>
<td>Actual settling error from simulation</td>
<td>Ensure $V_{err} &lt; V_{err\text{max}}$ Otherwise, additional design iteration is needed</td>
<td></td>
</tr>
</tbody>
</table>
4 Charge-Sharing Circuit Simulation Methods

The following sections describe how to perform simulations to determine the settling error from a charge-sharing ADC driving circuit. PSpice for TI models for many C2000 devices are provided with this application report here: http://www.ti.com/lit/zip/spracz0. More detail on building a PSpice for TI based ADC input model can be found in TI Precision Labs - SAR ADC Input Driver Design. More detail on building a C2000-specific PSpice for TI model can be found in ADC Input Circuit Evaluation for C2000 MCUs.

4.1 Simulation Components

Figure 4-1 and Figure 4-2 show the components in the PSpice for TI simulation setup.

Figure 4-1. Simulation Schematic (No Op-Amp)

4.1.1 \( V_{in} \)

\( V_{in} \) is the applied voltage. The S+H capacitor (\( C_H \)) needs to be charged to within the settling error tolerance by the end of the S+H period. While any input can be simulated, applying a full-scale DC input voltage while the model fully discharges \( C_H \) between every sample will provide worst-case settling conditions.

4.1.2 \( V_{oa} \), \( V_{oa:ss} \), and \( V_{error} \)

PSpice for TI op-amp models incorporate various non-idealities, which results in the DC steady state output of the op-amp at \( V_{oa} \) not exactly matching \( V_{in} \). The steady state output at \( V_{oa} \) can be simulated and entered into \( V_{oa:ss} \) such that \( V_{error} \) is an accurate representation of only the input settling error. In the case that no op-amp is used in the charge-sharing input design, \( V_{oa:ss} \) should be set to exactly \( V_{in} \).

4.1.3 \( R_s \), \( C_s \), and \( V_{cont} \)

\( R_s \) and \( C_s \) are the source resistance and source capacitance. These values correspond to \( R_{filt} \) and \( C_{filt} \) in the TI Precision Labs training terminology. \( R_s \) resistance is determined by the global parameter \( R_{STEP} \). Using a global parameter allows parameter sweeping when there are two \( R_s \) resistors in the differential models.

4.1.4 \( C_h \), \( R_{on} \), and \( C_p \)

Component values for the ADC input model.

\( C_h \), the S+H capacitor. The goal of the simulation is to charge this capacitor to as close as possible to \( V_{in} \) during the S+H window.

\( C_p \) is the pin-specific input capacitance. Can be optionally added to the simulation to improve simulation accuracy. This is particularly helpful for pins that are multiplexed with VDAC (alternate DAC voltage reference pin) that have a value of \( C_p \), which is greater than 100 pF on most devices.

Pins that are multiplexed with the buffered DAC output on F2837x and F2807x devices have a parasitic 50 kΩ pull-down resistor present. It is recommended to add this resistor to the model (not shown in Figure 4-1 or Figure 4-2) to better represent behavior of these pins.
4.1.5 S+H Switch, Discharge Switch, $t_{\text{acq}}$, and $t_{\text{dis}}$

Switch "S+H" controls when the S+H capacitor, $C_h$, is being charged by the driving circuit. The timings for this switch are controlled by $t_{\text{acq}}$.

Switch "Discharge" controls when the S+H capacitor, $C_h$, is being reset by being discharged to ground. The timings for this switch are controlled by $t_{\text{dis}}$.

When neither $t_{\text{acq}}$ or $t_{\text{dis}}$ are active, the value of the S+H capacitor is held at its final settled values.

Additional information on how to configure these switches based on the desired charge-sharing simulation parameters can be found in Section 4.2.

CAUTION

While the ADC input models for multiple C2000 devices are bundled with this application report, input model component values should always first be verified with the device-specific data manual before proceeding. Values for $C_h$ and $R_{\text{on}}$ can be obtained from the Input Model Parameters table in the device-specific data manual while values for $C_p$ can be obtained from the Per-Channel Parasitic Capacitance table. In any cases where the device-specific data manual values disagree with the values in this document or in the provided models, the device-specific data manual values should always be considered the correct values.

![Figure 4-2. Simulation Schematic](image-url)
4.2 Configure the Simulation Parameters

The primary configuration that needs to be done for charge-sharing simulations is to set the sample rate. This is controlled by settings of the piecewise linear voltage sources $t_{\text{acq}}$ and $t_{\text{dis}}$. The secondary configuration of PSpice for TI simulation parameters is also necessary to optimize simulation results.

Sample $t_{\text{acq}}$ timing configurations for a 100 ns acquisition window and 100kHz sampling are shown in Figure 4-3. The first four lines configure the S+H window to occur from 0 to 102 ns with 1 ns rise and fall times. The last line (which is of primary interest) configures how often the waveform repeats. This effectively sets the sample rate, so 10000 ns (10 µs) is equivalent to 100 kHz sampling.

![Figure 4-3. Example Timings for $t_{\text{acq}}$ (Piecewise Linear)](image)

Sample $t_{\text{dis}}$ timing configurations for a 100 ns discharge period and 100 kHz sampling are shown in Figure 4-4. The first five lines specify a 100 ns discharge period with 10ns rise and fall times starting at 9.87 µs. The last line configures how often the waveform repeats. This effectively sets the sample rate, so 10000 ns (10 µs) is equivalent to 100 kHz sampling. Ensure that the last line of the $t_{\text{dis}}$ and $t_{\text{acq}}$ timings always exactly match! It is not necessary for this discharge period to occur exactly at the end of the triggering period, so it is acceptable to change the sampling rate by only changing the last line. For example, changing the final line of both $t_{\text{dis}}$ and $t_{\text{acq}}$ to 20000 ns will change the sample rate to 50 kHz. Do, however, ensure that the discharge period does not overlap with the S+H period in $t_{\text{acq}}$ as this will result in the input being shorted to ground instead of charging $C_H$.

Figure 4-4. Example Timings for $t_{\text{dis}}$ (Piecewise Linear)

Note that the timings are configured to emulate conversions triggered at 100 kHz frequency. This slower sample rate on a specific channel is typical of a charge-sharing input design (instead of back-to-back continuous conversions at the max ADC sample rate). The triggering rate can be modified to match the actual application ePWM trigger rate by modifying the period of the $t_{\text{acq}}$ and $t_{\text{dis}}$ timing sources. Do, however, ensure that the trigger rate is slower than the total acquisition time plus ADC conversion time. The ADC conversion time can be found in the device-specific data manual table "ADC Timings".

When a simulation is run, the PSpice for TI simulation parameters also need to be configured for maximum accuracy. To increase the numeric precision of bias point simulation results, go to PSpice ➔ Bias Points ➔ Preferences... and increase the Displayed Precision parameter. To optimize transient simulation results, open the transient simulation profile and decrease the maximum step size. To increase the numeric precision of simulation results in the PSpice for TI simulation window, go to Tools ➔ Options... ➔ Cursor Settings and increase the number of cursor digits.

This application report requires precision on the level of microvolts. For this reason, ensure that the Displayed Precision parameter and number of cursor digits are greater than or equal to 7. The maximum step size is configured on a simulation-by-simulation basis, but a maximum step size that is three to four orders of magnitude smaller than the simulation stop time is generally sufficient.
4.3 Bias Point Analysis to Determine $V_{oa_{ss}}$

Charge-sharing settling input designs do not always include an op-amp, but when the signal chain of interest does, steps must be taken to account for the DC voltage errors modeled in the PSpice for TI models. This ensures that the simulation only measures settling performance. To accomplish this, it is necessary to determine the steady-state output value for $V_{oa}$ given the specific op-amp being included. This value must then be copied to the $V_{oa_{ss}}$ voltage source.

Perform a bias point analysis to determine the steady-state output value for $V_{oa}$ given the specific op-amp being included. Performing a bias point analysis in PSpice for TI requires the creation of a Bias Point simulation profile. Once the simulation profile is created, go to PSpice $\rightarrow$ Run to perform the analysis. Perform a bias point analysis using the simulation profile shown in Figure 4-5.
If the bias point analysis does not converge, then a transient analysis must be performed instead to determine the steady-state output value for $V_{oa}$ given the specific op-amp being included. Close the PSpice for TI simulation window and refer to the next section, Section 4.4, for instructions on how to proceed. If the bias point analysis converges, close the PSpice for TI simulation window. Using the menu in the upper left of the PSpice for TI schematic capture window, go to PSpice ➔ Bias Points and enable bias voltage display. The bias voltages should appear as shown in Figure 4-6.

![Figure 4-6. Bias Point Analysis Results](image)

The bias voltage of the node at the output of the specific op-amp being included is the steady-state output value for $V_{oa}$. For OPA350 in this circuit, this procedure gives:

- $V_{oa} = 3.000141$ V

Copy this value to the $V_{oa_{ss}}$ voltage source as shown in Figure 4-7.

**CAUTION**

Ensure that the steady-state output value for $V_{oa}$ is accurate to the microvolt (there are at least six digits following the decimal point). For guidance on how to optimize simulation results, see Section 4.2.
Because the steady-state output value for $V_{oa}$ given the specific op-amp being included is known, skip the next section, Section 4.4, and refer to Section 4.5 for instructions on how to proceed.

**Note**

Note that the remainder of the application report assumes that the bias point analysis converges. If the bias point analysis does not converge, then any transient analyses must skip the initial bias point calculation. However, if the bias point analysis converges, then any transient analyses should not skip the initial bias point calculation. Thus, subsequent transient analyses in this application report do not skip the initial bias point calculation.

**Figure 4-7. Nodal Analysis Example**

A bias point analysis can also be used to determine the expected output voltage of a voltage divider. Apply a DC input voltage to the divider and copy the nodal output voltage to $V_{oa_{ss}}$. 
4.4 Transient Analysis to Determine $V_{oa_{ss}}$

Charge-sharing settling input designs do not always include an op-amp, but when the signal chain of interest does, steps must be taken to account for the DC voltage errors modeled in the PSpice for TI models. This ensures that the simulation only measures settling performance. To accomplish this, it is necessary to determine the steady-state output value for $V_{oa}$ given the specific op-amp being included. This value must then be copied to the $V_{oa_{ss}}$ voltage source.

Perform a transient analysis to determine the steady-state output value for $V_{oa}$ given the specific op-amp being included. Prior to the transient analysis, disconnect the left end of $R_{on}$ from the circuit and attach that end to ground. Note that a voltage level marker is already attached to the output of the op-amp. The modified circuit is shown in Figure 4-8.

![Figure 4-8. Transient Analysis Circuit](image)

Performing a transient analysis in PSpice for TI requires the creation of a Time Domain (Transient) simulation profile. Once the simulation profile is created, go to PSpice ➔ Run to perform the analysis. Perform a transient analysis using the simulation profile shown in Figure 4-9.

![Figure 4-9. Transient Analysis Simulation Profile](image)
Delete all outputs other than $V_{oa}$ and set $V_{oa}$ range to +2.95 V to +3.05 V. Alternatively, go to Window ➔ Display Control... using the menu in the upper left of the PSpice for TI simulation window to access a list of preset display configurations provided by TI. Restore the Steady-State Analysis display configuration. Note that these preset display configurations are only available in the PSpice for TI projects bundled with this application report. Then use a probe cursor to measure the steady-state output value for $V_{oa}$ as shown in Figure 4-10.

![Figure 4-10. Transient Analysis Results](image)

For OPA350 in this circuit, this procedure gives:

- $V_{oa} = 3.000208$ V

Copy this value to the $V_{oa_{ss}}$ voltage source as shown in Figure 4-11. Following the transient analysis, detach the left end of $R_{on}$ from ground and reconnect that end to the circuit.

**CAUTION**

Ensure that the steady-state output value for $V_{oa}$ is accurate to the microvolt (there are at least six digits following the decimal point). If necessary, see Section 4.2.

Now that the steady-state output value for $V_{oa}$ given the specific op-amp being included is known. For instruction on how to proceed, see Section 4.5.

**Note**

Note that the remainder of the application report assumes that the bias point analysis converges. If the bias point analysis converges, then any transient analyses should not skip the initial bias point calculation. Thus, subsequent transient analyses in this application report do not skip the initial bias point calculation. If the bias point analysis does not converge, then any transient analyses must skip the initial bias point calculation. Thus, subsequent transient analyses must skip the initial bias point calculation. For this reason, results obtained may vary from the results presented in this application report.
A transient analysis can also be used to determine the expected output voltage of a voltage divider. However, a bias point analysis is more appropriate. In either case, apply a DC input voltage to the divider and copy the nodal output voltage to $V_{oa_{SS}}$.

### 4.5 Measure the Settling Error

Once the circuit is built in PSpice for TI, the steady-state voltage is measured (if applicable), and the sample rate is configured, measuring the settling error is relatively straightforward. This can be accomplished by running a transient analysis over enough periods to ensure that the system reaches steady state. A good starting point is about 30 sampling periods.

Performing a transient analysis in PSpice for TI requires the creation of a Time Domain (Transient) simulation profile. Once the simulation profile is created, go to PSpice ➔ Run to perform the analysis. An example Time Domain (Transient) simulation profile is shown in Figure 4-12.
Figure 4-13 shows the results of this transient simulation profile applied to the example circuit in Figure 4-7 which has 100 nF $C_s$, 100 $\Omega$ $R_s$, and a 100 kHz sampling rate. After simulation, all outputs other than $V_{error}$ and $V_{pin}$ were deleted. The remaining output waveforms were separated onto different plots. $V_{error}$ range was set to -4 V to 0 V. $V_{pin}$ range was set to +2.999 V to +3 V. The easiest way to reproduce these display settings is to go to Window ➔ Display Control... using the menu in the upper left of the PSpice for TI simulation window to access a list of preset display configurations provided by TI. Restore the Settling Error display configuration. Note that these preset display configurations are only available in the PSpice for TI projects bundled with this application report.

To measure the total settling error, place a cursor at any point other than the S+H window on the $V_{error}$ trace. This simulation shows about 590 $\mu$V of settling error from this method (yellow cursor). Alternately, the minimum value of $V_{pin}$ can also be measured. This method shows approximately $3 \text{ V} - 2.999410 \text{ V} = 590 \mu\text{V}$ of settling error (blue cursor).
In addition, it is possible to separately measure the charge-share and tracking errors. Figure 4-14 shows the results of narrowing the simulation to 20 periods and also deleting the $V_{\text{error}}$ trace. The distance from 3 V to max value of $V_{\text{pin}}$ in steady state is the approximate tracking error. In this case, the tracking error is $3 \, V - 2.999782 \, V = 218 \, \mu V$ (blue cursor). Similarly, the charge-share error is the difference between the tracking error point and the minimum pin voltage in the steady state. In this case, the charge-share error is $2.999782 \, V - 2.999409 \, V = 373 \, \mu V$ (blue cursor minus yellow cursor).

**Figure 4-14. Settling Error Component Measurement**

### 4.6 Sweeping Source Resistance

It may sometimes be helpful to run simulations for a range of $R_s$ values. To accomplish this, create a transient simulation profile as shown in Figure 4-15. Then enable the Parametric Sweep option. In the Parametric Sweep settings, choose the global parameter $R_{\text{STEP}}$ as the sweep variable. Then choose a linear sweep type with a start value of 250 Ω, an end value of 750 Ω, and an increment of 250 Ω as shown in Figure 4-16.

**Figure 4-15. Transient Analysis Simulation Profile General Settings**
Once the Parametric Sweep option is configured, a transient analysis can be run as usual. The simulation will now produce an output waveform for each resistance value in the sweep. After simulation, delete all outputs other than $V_{pin}$ and set $V_{pin}$ range to +2.995 V to +3 V. Alternatively, go to Window ➔ Display Control... using the menu in the upper left of the PSpice for TI simulation window to access a list of preset display configurations provided by TI. Restore the Sweep Results display configuration. Note that these preset display configurations are only available in the PSpice for TI projects bundled with this application report. Figure 4-17 shows the results of simulating 100kHz sampling with 250 Ω, 500 Ω, and 750 Ω source resistance values. It is recommended to view the results of all output curves simultaneously by placing a probe cursor as shown in Figure 4-17.
5 Example Circuit Designs

The following sections apply the analysis and simulation methods to a series of examples.

5.1 Example 1: Determining Maximum Sample Rate

In this example a sensor with known output impedance of 500 Ω is to be connected to the 12-bit ADC of an F28004x device without an op-amp (if possible). The ADC is operating with a 3.0 V external reference. Analysis and simulation will be used to determine the maximum rate the sensor should be sampled at. Full settling performance of 12+1 bits is desired and the signal bandwidth is low (assume 500 Hz).

5.1.1 Example 1: Analysis

The $C_H$ value of the F28004x ADC is determined to be 12.5 pF from the device-specific data manual. $C_p$ is assumed to be negligible. $C_s$ is therefore sized accordingly:

$$C_s = (2^{N+2} \cdot C_p) - C_p = (2^{12+2} \cdot 12.5 \text{ pF}) - 0 \text{ pF} = 205 \text{ nF} \quad (14)$$

Which is then rounded up to $C_s = 220 \text{ nF}$. The maximum sample rate is then calculated using Equation 15:

$$f_{smax} = \frac{1}{0.7 \cdot R_s \cdot C_s} = \frac{1}{0.7 \cdot 500 \text{ Ω} \cdot 220 \text{ nF}} = 13 \text{ kHz} \quad (15)$$

Finally, the external low-pass filter bandwidth is:

$$BW_{R_sC_s} = \frac{1}{2\pi \cdot C_s \cdot R_s} = \frac{1}{2\pi \cdot 220 \text{ nF} \cdot 500 \text{ Ω}} = 1.4 \text{ kHz} \quad (16)$$

5.1.2 Example 1: Simulation

The circuit to simulate is shown in Figure 5-1. No steady state analysis is needed because there is no op-amp. A transient analysis whose simulation profile is shown in Figure 5-2 is run over 3 ms as shown in Figure 5-3, resulting in a measured total settling time measurement of 3 V - 2.999662 V = 338 µV, which is under the target settling error of $3 \text{ V} / 2^{12+1} = 366 \text{ µV}$.

![Figure 5-1. Example 1: Simulation Circuit](image-url)
Figure 5-2. Example 1: Simulation Profile

Figure 5-3. Example 1: Simulation Results
5.1.3 Example 1: Worksheet

Table 5-1. Example 1: ADC Charge Sharing Design Worksheet

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Target settling resolution (bits)</td>
<td>12</td>
<td>Usually the same as the resolution of the ADC. Lower resolution can be targeted to relax the input design requirements</td>
</tr>
<tr>
<td>$V_{fs}$</td>
<td>Full scale voltage range</td>
<td>3.0 V</td>
<td>In external reference mode, this is the voltage supplied to the VREFHI pin (usually 3.0 V or 2.5 V). In internal reference mode, this is the effective input range based on the selected reference mode (usually 3.3 V or 2.5 V)</td>
</tr>
<tr>
<td>$V_{error}$</td>
<td>Maximum error target</td>
<td>366 µV</td>
<td>$V_{fs}/2^{N+1}$ Can be further divided into two components: charge-sharing error and tracking error, each $V_{error}/2$</td>
</tr>
<tr>
<td>$t_{sh}$</td>
<td>S+H time</td>
<td>80 ns</td>
<td>As long as $C_s$ is sized appropriately for charge-sharing, the minimum value from the ADC data manual can be used.</td>
</tr>
<tr>
<td>$C_h$</td>
<td>ADC S+H capacitance</td>
<td>12.5 pF</td>
<td>Provided in the data manual table “Input Model Parameters”</td>
</tr>
<tr>
<td>$C_p$</td>
<td>ADC pin parasitic capacitance</td>
<td>0 pF (assumed negligible)</td>
<td>Provided in the data manual table “Per-Channel Parasitic Capacitance”</td>
</tr>
<tr>
<td>$C_s$</td>
<td>Source capacitance</td>
<td>220 nF</td>
<td>At least $(2^{N+2} \cdot C_h) - C_p$</td>
</tr>
<tr>
<td>$R_s$</td>
<td>Source resistance</td>
<td>500Ω</td>
<td>Output resistance of source driving ADC. Can also be intentionally selected.</td>
</tr>
<tr>
<td>$f_s$</td>
<td>Sample Rate</td>
<td>N/A</td>
<td>Sample rate on channel of interest. Usually a requirement from the application.</td>
</tr>
<tr>
<td>$BW_s$</td>
<td>Source signal required bandwidth.</td>
<td>500 Hz</td>
<td>Source signal required bandwidth.</td>
</tr>
<tr>
<td>$R_{smax}$</td>
<td>Max allowable source resistance</td>
<td>N/A</td>
<td>If $f_s$ is known, calculate as $1 / (0.7 \cdot f_s \cdot C_s)$, then ensure that $R_s &lt; R_{smax}$. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>$f_{smax}$</td>
<td>Max allowable sampling frequency</td>
<td>13 kHz</td>
<td>If $f_s$ is known, calculate as $1 / (0.7 \cdot R_s \cdot C_s)$, then ensure that $f_s &lt; f_{smax}$. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>$BW_{RsCs}$</td>
<td>Filter bandwidth from $C_s$ and $R_s$</td>
<td>1.4 kHz</td>
<td>$1 / (2\pi \cdot C_s \cdot R_s)$ Ensure that $BW_{RsCs} &gt; BW_s$, otherwise additional design iteration is needed.</td>
</tr>
<tr>
<td>$V_{oa_{ss}}$</td>
<td>Steady state op-amp output voltage</td>
<td>3.0V</td>
<td>If no op-amp is used, set $V_{oa_{ss}} = V_{fs}$. Otherwise, this can be generated from DC nodal analysis of the $V_{oa}$ node. Copy to $Voa_{ss}$ before proceeding with other simulations.</td>
</tr>
<tr>
<td>BWOPA</td>
<td>ADC driver op-amp minimum bandwidth</td>
<td>N/A</td>
<td>If an op-amp is needed, bandwidth should be at least 4 times BW_{RsCs}</td>
</tr>
<tr>
<td>Op-amp</td>
<td>Selected Op-amp part number</td>
<td>N/A</td>
<td>Record selected op-amp here (if needed).</td>
</tr>
<tr>
<td>$V_{err}$</td>
<td>Actual settling error from simulation</td>
<td>338 µV</td>
<td>Ensure $V_{err} &lt; V_{error}$ Otherwise, additional design iteration is needed</td>
</tr>
</tbody>
</table>

5.2 Example 2: Adding an Op-amp

In this example, consider a situation similar to Section 5.1. A sensor with known output impedance of 500 Ω is to be connected to the 12-bit ADC of an F28004x device. However, this time assume the sensor bandwidth is much higher: 10 kHz, and the system uses a fixed sampling rate of 24 ksps. The ADC is operating with a 3.0 V external reference and full settling performance of 12+1 bits is still desired.

5.2.1 Example 2: Analysis

Example 1 determined that the maximum sample rate with 500 Ω source resistance was 13 ksps. Since the requirement for 24 ksps sampling was added in this example, some changes will be needed. One possibility would be to relax the settling performance (see Section 5.3), but this example instead isolates the source resistance using an op-amp.

$C_s$ will remain 220 nF and the maximum $R_s$ can then be calculated using Equation 17:

$$R_{smax} = 1 / (0.7 \cdot f_s \cdot C_s) = 0.7 / (0.7 \cdot 24 \text{ kHz} \cdot 220 \text{ nF}) = 270 \Omega \quad (17)$$
Since the op-amp isolates the original source resistance of 500 Ω, $R_s$ can be selected to be any value less than 270 Ω. Since the signal has 10 kHz bandwidth, $R_s$ should be selected to be no more than 68 Ω, since this gives a bandwidth just over the signal bandwidth of 10 kHz:

$$BW_{RsCs} = \frac{1}{(2\pi \cdot C_s \cdot R_s)} = \frac{1}{(2\pi \cdot 220 \text{ nF} \cdot 68 \Omega)} = 10.6 \text{ kHz}$$

(18)

$R_s$ could also be selected to be 56 Ω, as this standard resistor value gives a filter bandwidth just over 12 kHz, resulting in an anti-aliasing filter for the 24 kHz sampling.

When selecting the op-amp, a bandwidth of at least 4 time $BW_{RsCs}$ should be selected. In this case, the bandwidth required would be at least 40 kHz, which is a very easy requirement to meet. TLV07 was selected due to low cost, low noise, low $V_{os}$, and ample bandwidth for this application.

**5.2.2 Example 2: Simulation**

Since this input design contains an op-amp, the first step is to perform a transient analysis to determine the steady-state output voltage of the op-amp. Note that this application report performs a transient analysis because a bias point analysis does not converge. The voltage is determined to be 2.999995 V. The full simulation circuit (populated to include $V_{oa_{ss}} = 2.999995$ V) can be seen in Figure 5-4. The simulation profile can be seen in Figure 5-5.

![Figure 5-4. Example 2: Simulation Circuit](image)
Figure 5-5. Example 2: Simulation Profile

Running the transient analysis from 1 ms to 2 ms gives the results seen in Figure 5-6. The overall settling error is around $2.999995 \text{ V} - 2.999813 \text{ V} = 182 \mu\text{V}$. This is well within the settling error target of 366 $\mu\text{V}$.

Figure 5-6. Example 2: Simulation Results

Because the op-amp is driving a large capacitive load, it is also good practice to run a phase margin simulation to ensure the driving op-amp is stable. The circuit setup for this can be seen in Figure 5-7, the simulation profile can be seen in Figure 5-8, and the results can be seen in Figure 5-9. The measured phase margin is 65 degrees. Since this is > 45 degrees, the circuit can be assumed to be stable. For more information on how to run the stability simulation refer to the TI Precision Labs video series: TI Precision Labs - Op amps: Stability. Note that while this video series describes conceptually how to perform these simulations, the video series does not provide explicit instructions on how to perform these simulations using PSpice for TI. Further exploration of these simulations using PSpice for TI is beyond the scope of this application report.
Figure 5-7. Example 2: Stability Simulation Circuit

Figure 5-8. Example 2: Stability Simulation Profile
5.2.3 Example 2: Worksheet

Table 5-2. Example 2: ADC Charge Sharing Design Worksheet

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Target settling resolution (bits)</td>
<td>12</td>
<td>Usually the same as the resolution of the ADC. Lower resolution can be targeted to relax the input design requirements</td>
</tr>
<tr>
<td>V_fs</td>
<td>Full scale voltage range</td>
<td>3.0 V</td>
<td>In external reference mode, this is the voltage supplied to the VREFHI pin (usually 3.0 V or 2.5 V) In internal reference mode, this is the effective input range based on the selected reference mode (usually 3.3 V or 2.5 V)</td>
</tr>
<tr>
<td>V_errmax</td>
<td>Maximum error target</td>
<td>366 µV</td>
<td>V_fs / 2^(N+1) Can be further divided into two components: charge-sharing error and tracking error, each V_errmax / 2</td>
</tr>
<tr>
<td>t_sh</td>
<td>S+H time</td>
<td>80 ns</td>
<td>As long as C_s is sized appropriately for charge-sharing, the minimum value from the ADC data manual can be used.</td>
</tr>
<tr>
<td>C_h</td>
<td>ADC S+H capacitance</td>
<td>12.5 pF</td>
<td>Provided in the data manual table &quot;Input Model Parameters&quot;</td>
</tr>
<tr>
<td>C_p</td>
<td>ADC pin parasitic capacitance</td>
<td>0 pF (assumed negligible)</td>
<td>Provided in the data manual table &quot;Per-Channel Parasitic Capacitance&quot;</td>
</tr>
<tr>
<td>C_s</td>
<td>Source capacitance</td>
<td>220 nF</td>
<td>At least (2^(N+2) ⋅ C_h) - C_p</td>
</tr>
<tr>
<td>R_s</td>
<td>Source resistance</td>
<td>68Ω</td>
<td>Output resistance of source driving ADC. Can also be intentionally selected.</td>
</tr>
<tr>
<td>f_s</td>
<td>Sample Rate</td>
<td>24 ksps</td>
<td>Sample rate on channel of interest. Usually a requirement from the application.</td>
</tr>
<tr>
<td>BW_s</td>
<td>Source signal required bandwidth</td>
<td>10 kHz</td>
<td>Source signal required bandwidth.</td>
</tr>
<tr>
<td>R_smax</td>
<td>Max allowable source resistance</td>
<td>270Ω</td>
<td>If f_s is known, calculate as 1 / (0.7 ⋅ f_s ⋅ C_s) , then ensure that R_s &lt; R_smax. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>f_max</td>
<td>Max allowable sampling frequency</td>
<td>N/A</td>
<td>If R_s is known, calculate as 1 / (0.7 ⋅ R_s ⋅ C_s) , then ensure that f_s &lt; f_max. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>BW_RsCs</td>
<td>Filter bandwidth from C_s and R_s</td>
<td>10.6 kHz</td>
<td>1 / (2π ⋅ C_s ⋅ R_s) Ensure that BW_RsCs &gt; BW_s , otherwise additional design iteration is needed.</td>
</tr>
<tr>
<td>V_0a_ss</td>
<td>Steady state op-amp output voltage</td>
<td>2.999997 V</td>
<td>If no op-amp is used, set V_0a_ss = V_fs. Otherwise, this can be generated from DC nodal analysis of the V_0a node. Copy to Voa_ss before proceeding with other simulations.</td>
</tr>
<tr>
<td>BWOPA</td>
<td>ADC driver op-amp minimum bandwidth</td>
<td>40 kHz</td>
<td>If an op-amp is needed, bandwidth should be at least 4 times BWRsCs</td>
</tr>
<tr>
<td>Op-amp</td>
<td>Selected Op-amp part number</td>
<td>TLV07</td>
<td>Record selected op-amp here (if needed).</td>
</tr>
</tbody>
</table>

Figure 5-9. Example 2: Stability Simulation Results
Table 5-2. Example 2: ADC Charge Sharing Design Worksheet (continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
</table>
| $V_{err}$ | Actual settling error from simulation | 183 µV | Ensure $V_{err} < V_{err\text{max}}$  
Otherwise, additional design iteration is needed |

5.3 Example 3: Reduced Settling Target

In this example, consider a system with a fixed sampling rate of 96 ksps. A set of analog temperature sensors (yet to be selected) is to be connected to the 12-bit ADC of an F28004x device. The ADC is operating with a 3.0 V external reference. Analysis and simulation will be used to determine the maximum source resistance the sensor should exhibit to be directly connected using charge-sharing. The sensors only require 8-bit settling performance (~0.4%). Analysis and simulation will be used to determine the maximum source resistance that can be supported for this set of sensors.

5.3.1 Example 3: Analysis

The $C_H$ value of the F28004x ADC can be found to be 12.5 pF in the device-specific data manual. $C_p$ is assumed to be negligible. $C_s$ is therefore sized, assuming a reduced settling performance:

$$C_s = (2^{N+2} \cdot C_H) - C_p = (2^{8+1} \cdot 12.5 \text{ pF}) - 0 \text{ pF} = 6.4 \text{ nF}$$

(19)

Which is then rounded up to $C_s = 6.8 \text{ nF}$. The maximum source resistance can then be calculated using Equation 20:

$$R_{s_{\text{max}}} = \frac{1}{(0.7 \cdot f_s \cdot C_s)} = \frac{1}{(0.7 \cdot 96 \text{ ksps} \cdot 6.8 \text{ nF})} = 2188 \Omega$$

(20)

If the temperature sensor has an output impedance of about 2.2 kΩ or lower, it should be possible to directly interface it to the ADC using a charge-sharing capacitor.

And the external low-pass filter bandwidth (assuming the maximum source resistance) would be:

$$BW_{R_sC_s} = \frac{1}{(2\pi \cdot C_s \cdot R_s)} = \frac{1}{(2\pi \cdot 6.8 \text{ nF} \cdot 2188 \Omega)} = 10.7 \text{ kHz}$$

(21)

Which should be plenty for a temperature sensor. Furthermore, if the selected temperature sensor has output resistance lower than 2.2 kΩ, intentional series resistance could be added to reduce the filter bandwidth (for noise rejection purposes). Alternately, $C_s$ could also instead be increased, which has the advantage of providing better charge-sharing settling performance and not adding an additional component.
5.3.2 Example 3: Simulation

The simulation is setup using the worst-case source impedance as shown in Figure 5-10. A transient analysis whose simulation profile is shown in Figure 5-11 is then run from 500 µs to 750 µs, resulting in the measured waveform as shown in Figure 5-12. The final measured settling error is $3 \text{ V} - 2.989125 \text{ V} = 10.9 \text{ mV} = 14.8 \text{ LSBs}$ $= 0.36\%$ of full-scale range. This is within the settling error target of 0.4%.

![Figure 5-10. Example 3: Simulation Circuit](image1)

![Figure 5-11. Example 3: Simulation Profile](image2)
5.3.3 Example 3: Worksheet

Table 5-3. Example 3: ADC Charge Sharing Design Worksheet

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Target settling resolution (bits)</td>
<td>7</td>
<td>(to get 8-bit settling)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Usually the same as the resolution of the ADC. Lower resolution can be targeted to relax the input design requirements</td>
</tr>
<tr>
<td>Vfs</td>
<td>Full scale voltage range</td>
<td>3.0 V</td>
<td>In external reference mode, this is the voltage supplied to the VREFHI pin (usually 3.0 V or 2.5 V)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In internal reference mode, this is the effective input range based on the selected reference mode (usually 3.3 V or 2.5 V)</td>
</tr>
<tr>
<td>Vermax</td>
<td>Maximum error target</td>
<td>11.7 mV</td>
<td>Vfs / 2^(N+1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Can be further divided into two components: charge-sharing error and tracking error, each Vermax / 2</td>
</tr>
<tr>
<td>tsh</td>
<td>S+H time</td>
<td>80 ns</td>
<td>As long as Cs is sized appropriately for charge-sharing, the minimum value from the ADC data manual can be used.</td>
</tr>
<tr>
<td>C_h</td>
<td>ADC S+H capacitance</td>
<td>12.5 pF</td>
<td>Provided in the data manual table &quot;Input Model Parameters&quot;</td>
</tr>
<tr>
<td>C_p</td>
<td>ADC pin parasitic capacitance</td>
<td>0 pF (assumed negligible)</td>
<td>Provided in the data manual table &quot;Per-Channel Parasitic Capacitance&quot;</td>
</tr>
<tr>
<td>Cs</td>
<td>Source capacitance</td>
<td>6.8 nF</td>
<td>At least (2^(N+2) * C_h) - C_p</td>
</tr>
<tr>
<td>Rs</td>
<td>Source resistance</td>
<td>N/A</td>
<td>Output resistance of source driving ADC. Can also be intentionally selected.</td>
</tr>
<tr>
<td>fs</td>
<td>Sample Rate</td>
<td>96 ksps</td>
<td>Sample rate on channel of interest. Usually a requirement from the application.</td>
</tr>
<tr>
<td>BWs</td>
<td>Source signal required bandwidth</td>
<td>low</td>
<td>Source signal required bandwidth.</td>
</tr>
<tr>
<td>R_smax</td>
<td>Max allowable source resistance</td>
<td>2188Ω</td>
<td>If Rs is known, calculate as 1 / (0.7<em>Rs</em>Cs), then ensure that Rs &lt; R_smax. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>f_smax</td>
<td>Max allowable sampling frequency</td>
<td>N/A</td>
<td>If Rs is known, calculate as 1 / (0.7<em>Rs</em>Cs), then ensure that f_s &lt; f_smax. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>BW_Rscs</td>
<td>Filter bandwidth from Cs and Rs</td>
<td>10.7 kHz</td>
<td>1 / (2 * pi * Cs * Rs ) Ensure that BW_Rscs &gt; BWs, otherwise additional design iteration is needed.</td>
</tr>
<tr>
<td>Voa_ss</td>
<td>Steady state op-amp output voltage</td>
<td>3 V</td>
<td>If no op-amp is used, set Voa_ss = Vfs. Otherwise, this can be generated from DC nodal analysis of the Voa node. Copy to Voa_ss before proceeding with other simulations.</td>
</tr>
</tbody>
</table>
Table 5-3. Example 3: ADC Charge Sharing Design Worksheet (continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>BWOPA</td>
<td>ADC driver op-amp minimum bandwidth</td>
<td>N/A</td>
<td>If an op-amp is needed, bandwidth should be at least 4 times BWRsCs</td>
</tr>
<tr>
<td>Op-amp</td>
<td>Selected Op-amp part number</td>
<td>N/A</td>
<td>Record selected op-amp here (if needed).</td>
</tr>
<tr>
<td>V_{err}</td>
<td>Actual settling error from simulation</td>
<td>10.9 mV</td>
<td>Ensure (V_{err} &lt; V_{errmax}) Otherwise, additional design iteration is needed</td>
</tr>
</tbody>
</table>

5.4 Example 4: Voltage Divider

In this example, consider sampling of a 400 V bus using a voltage divider. A voltage divider comprised of a 160 kΩ and 1.2 kΩ resistors will provide an attenuation factor of 0.00744, mapping a 400 V input to 2.978 V on the ADC input. This will be connected to the 12-bit ADC of an F28004x device. The ADC is operating with a 3.0 V external reference. Analysis and simulation will be used to determine the maximum sampling rate and the signal bandwidth this divider can support. 10 + 1 bit (< 0.1%) settling performance is required.

5.4.1 Example 4: Analysis

The \(C_H\) value of the F28004x ADC is determined to be 12.5 pF from the device-specific data manual. \(C_p\) is assumed to be negligible. \(C_s\) is therefore sized accordingly:

\[
C_s = (2^{N+2} \cdot C_H) - C_p = (2^{10+2} \cdot 12.5 \, \text{pF}) - 0 \, \text{pF} = 51.2 \, \text{nF}
\]

(22)

Which is then rounded to \(C_s = 51 \, \text{nF}\).

The equivalent series resistance of the voltage divider is 1.2 kΩ \| 160 kΩ = 1191 Ω. The maximum sample rate is then calculated using the equation:

\[
f_{s_{\text{max}}} = 1 / (0.7 \times R_s \times C_s) = 1 / (0.7 \times 1191 \, \Omega \times 51 \, \text{nF}) = 23.5 \, \text{kHz}
\]

And the external low-pass filter bandwidth is:

\[
BW_{RsCs} = 1 / (2\pi C_s R_s) = 1 / (2\pi \times 51 \, \text{nF} \times 1191 \, \Omega) = 2.6 \, \text{kHz}
\]

(23)

If a higher sample rate is needed, an op-amp can be added to isolate the equivalent resistance of the voltage divider from the ADC input (see Section 5.2). Alternately, both legs of the voltage divider can be proportionally reduced in resistance. This results in a lower equivalent resistance (and thus faster allowable sampling speed) at the expense of additional static current draw through the voltage divider.

5.4.2 Example 4: Simulation

The first step for simulating the ADC driver behavior is to determine the DC voltage at the output of the voltage divider assuming a 400 V input. This can done using the same method as the op-amp steady state voltage output: a bias point analysis. The annotated circuit following this analysis is shown in Figure 5-13. It can be seen that the voltage divider output is 2.977667 V. This value is copied to \(V_{oa_{ss}}\) so that the value of \(V_{err}\) correctly reflects only the settling error. Finally, a transient analysis whose simulation profile is shown in Figure 5-14 is run from 1 ms to 2 ms. The results can be seen in Figure 5-15. The final settling error is 2.977667 V - 2.976219 V = 1.45 mV
Figure 5-13. Example 4: Simulation Circuit

Figure 5-14. Example 4: Simulation Profile
### 5.4.3 Example 4: Worksheet

#### Table 5-4. Example 4: ADC Charge Sharing Design Worksheet

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Target settling resolution (bits)</td>
<td>10</td>
<td>Usually the same as the resolution of the ADC. Lower resolution can be targeted to relax the input design requirements</td>
</tr>
<tr>
<td>$V_{fs}$</td>
<td>Full scale voltage range</td>
<td>3.0 V</td>
<td>In external reference mode, this is the voltage supplied to the VREFHI pin (usually 3.0 V or 2.5 V) In internal reference mode, this is the effective input range based on the selected reference mode (usually 3.3 V or 2.5 V)</td>
</tr>
<tr>
<td>$V_{err_{max}}$</td>
<td>Maximum error target</td>
<td>1.46 mV</td>
<td>$V_{fs}/2^{N+1}$</td>
</tr>
<tr>
<td>$t_{sh}$</td>
<td>S+H time</td>
<td>80 ns</td>
<td>As long as $C_s$ is sized appropriately for charge-sharing, the minimum value from the ADC data manual can be used.</td>
</tr>
<tr>
<td>$C_h$</td>
<td>ADC S+H capacitance</td>
<td>12.5 pF</td>
<td>Provided in the data manual table &quot;Input Model Parameters&quot;</td>
</tr>
<tr>
<td>$C_p$</td>
<td>ADC pin parasitic capacitance</td>
<td>0 pF (assumed negligible)</td>
<td>Provided in the data manual table &quot;Per-Channel Parasitic Capacitance&quot;</td>
</tr>
<tr>
<td>$C_s$</td>
<td>Source capacitance</td>
<td>51 nF</td>
<td>At least $(2^{N+2} \cdot C_h) - C_p$</td>
</tr>
<tr>
<td>$R_s$</td>
<td>Source resistance</td>
<td>1191Ω</td>
<td>Output resistance of source driving ADC. Can also be intentionally selected.</td>
</tr>
<tr>
<td>$f_s$</td>
<td>Sample Rate</td>
<td>N/A</td>
<td>Sample rate on channel of interest. Usually a requirement from the application.</td>
</tr>
<tr>
<td>$BW_s$</td>
<td>Source signal required bandwidth.</td>
<td></td>
<td>Source signal required bandwidth.</td>
</tr>
<tr>
<td>$R_{smax}$</td>
<td>Max allowable source resistance</td>
<td>N/A</td>
<td>If $f_s$ is known, calculate as $1 / (0.7 \cdot f_s \cdot C_s)$, then ensure that $R_s &lt; R_{smax}$. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>$f_{smax}$</td>
<td>Max allowable sampling frequency</td>
<td>23.5 ksp</td>
<td>If $R_s$ is known, calculate as $1 / (0.7 \cdot R_s \cdot C_s)$, then ensure that $f_s &lt; f_{smax}$. If the condition is not met, additional design iteration is needed.</td>
</tr>
<tr>
<td>$BW_{RCs}$</td>
<td>Filter bandwidth from $C_s$ and $R_s$</td>
<td>2.6 kHz</td>
<td>$1 / (2\pi C_s R_s)$ Ensure that $BW_{RCs} &gt; BW_s$, otherwise additional design iteration is needed.</td>
</tr>
<tr>
<td>$V_{oa_{ss}}$</td>
<td>Steady state op-amp output voltage</td>
<td>2.977667 V</td>
<td>If no op-amp is used, set $V_{oa_{ss}} = V_{fs}$. Otherwise, this can be generated from DC nodal analysis of the $V_{oa}$ node. Copy to Voa_ss before proceeding with other simulations.</td>
</tr>
<tr>
<td>$BW_{OPA}$</td>
<td>ADC driver op-amp minimum bandwidth</td>
<td>N/A</td>
<td>If an op-amp is needed, bandwidth should be at least 4 times $BW_{RCs}$</td>
</tr>
</tbody>
</table>
Table 5-4. Example 4: ADC Charge Sharing Design Worksheet (continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Op-amp</td>
<td>Selected Op-amp part number</td>
<td>N/A</td>
<td>Record selected op-amp here (if needed).</td>
</tr>
<tr>
<td>$V_{err}$</td>
<td>Actual settling error from simulation</td>
<td>1.45 mV</td>
<td>Ensure $V_{err} &lt; V_{err\text{max}}$ Otherwise, additional design iteration is needed</td>
</tr>
</tbody>
</table>

6 Summary

Designing ADC signal conditioning circuits for proper input settling is necessary to achieve good sampling performance in real-time control applications. Using the analysis and simulation methods presented in this report, it is possible to create simple low-cost ADC driving circuits using the charge-sharing method. These circuits can also result in reduced sampling latency by allowing minimum S+H time and can reduce sampled noise by simultaneously providing low-pass filtering.
Appendix: ADC Input Settling Motivation

The following sections provide additional background on ADC input settling and the types of errors that can occur if proper input settling design is not achieved.

A.1 Mechanism of ADC Input Settling

To convert a sensed analog voltage to a digital conversion result, the ADC first must accurately capture the applied input voltage into its sample-and-hold circuit (S+H). As shown in Figure A-1, this entails charging the internal ADC S+H capacitor (C\textsubscript{h}) to within some acceptable tolerance (typically 0.5 LSBs) of the applied voltage within the configured acquisition window time (also referred to as the S+H time).

Quickly charging C\textsubscript{h} to the applied voltage is complicated by the finite bandwidth and settling time of the external ADC driver circuit and of the settling time of the internal ADC S+H circuit. In Figure A-1, the driver is show as an op-amp (OPA320), which has a finite bandwidth, and the driver circuit also has intentionally placed source resistance (R\textsubscript{s}) and intentionally placed source capacitance (C\textsubscript{s}) which have a finite settling time determined by their RC time constant. Note that other circuit topologies are possible for driving the ADC, and these circuits may have additional components that need to be modeled to ensure appropriate settling time. These components could include unintentional parasitics such as the output impedance of a sensor or the effective source resistance of a voltage divider. Figure A-1 also shows that the ADC has an internal parasitic switch resistance (R\textsubscript{on}). This, along with C\textsubscript{h}, provides an additional RC time constant that limits settling speed.

A.2 Symptoms of Inadequate Settling

Once a voltage has been captured into the S+H capacitor, the ADC will translate this voltage into a digital conversion result during the conversion phase. The CPU can then use this result to control or monitor the system. However, if the captured voltage does not accurately represent the applied voltage due to settling error, the final conversion result will have errors even if the ADC conversion process is perfect.

These settling errors will manifest differently depending on whether the ADC is sampling the same channel repeatedly or scanning through multiple channels in a sequence. The settling errors will also manifest differently depending on the starting voltage on the S+H capacitor at the beginning of the acquisition phase. Some ADC architectural implementations will have a starting S+H voltage close to the previously sampled voltage while other architectures will usually start the acquisition phase with a discharged S+H capacitor.
A.2.1 Distortion

In the case where the ADC is repeatedly sampling the same signal, settling error typically manifests as distortion of the input signal. In architectures where the S+H voltage starts near the previously sampled voltage, slow moving portions of the input signal will settle better than fast moving portions. An architecture where sequential samples begin their settling from the voltage sampled and held in the previous conversion is illustrated in Figure A-2.

![Figure A-2. Sequence of Samples With C_H Retained Between Conversions](image)

In architectures where the S+H capacitor starts each acquisition phase discharged, higher input voltages will have worse settling, resulting in distorted scaling of the signal. An architecture where sequential samples always beginning their settling from near zero-scale is illustrated in Figure A-3.

![Figure A-3. Sequence of Samples With C_H Discharged Between Conversions](image)
A.2.2 Memory Cross-Talk

In many C2000 real-time MCU applications, a typical use case is using the ADC input multiplexer to scan through multiple channels in a sequence. If a converted channel has inadequate settling, the channel may be pulled towards the voltage of the previous conversion in the sequence. This occurs because the S+H voltage starts near the previously converted voltage and then settles towards (but does not reach) the applied voltage. This tendency for the previous conversion result in a sequence of conversions to affect the current conversion is called memory cross-talk. Memory cross-talk can generally be completely mitigated via appropriate settling design.

A situation where a shared sample and hold must settle back-and-forth between two different multiplexed input signals is illustrated in Figure A-4.

![Figure A-4. Sequence of Multiplexed Samples](image)

Converter architectures that start with the S+H capacitor completely discharged generally do not experience significant memory cross-talk (but still experience input settling related distortion if the ADC driving circuits are not appropriate for the allocated acquisition time).

A.2.3 Accuracy

The errors introduced by inadequate input settling generally can not be calibrated out or reduced via oversampling and averaging. Therefore, applications that are concerned with absolute sampling accuracy also need to ensure proper ADC input settling even if the sensed input signal is low-frequency or even DC.

A.2.4 C2000 ADC Architecture

C2000 real-time MCU ADCs will generally start with the S+H capacitor pre-charged to a voltage close to the previous conversion result. The exception to this is for ADCs that support differential signaling, but which are operating in single-ended mode. In this case, the S+H capacitor will start discharged when the previous conversion was from an even numbered channel and the current channel is an odd numbered channel, or vice-versa. For example, the S+H capacitor will start discharged if channel A4 is being sampled after A3 (or vice-versa) but will start close to the previously converted voltage when sampling channel A4 after channel A2 or channel A1 after channel A3.
References

- TI Precision Labs - SAR ADC Input Driver Design
- Analog Engineer's Calculator
- TINA-TI
- PSPICE-FOR-TI
- Texas Instruments: ADC Input Circuit Evaluation for C2000 MCUs (using TINA-TI simulation tool)
- Texas Instruments: ADC Input Circuit Evaluation for C2000 Real-Time MCUs (using PSPICE-FOR-TI)
- Texas Instruments: Charge-Sharing Driving Circuits for C2000 ADCs (using TINA-TI simulation tool)
- Texas Instruments: Methods for Mitigating ADC Memory Cross-Talk
- TI Precision Labs - Op amps: Stability
- Texas Instruments: TMS320F28004x Microcontrollers Data Manual
- Texas Instruments: Selecting capacitors to minimize distortion in audio applications

Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

Changes from Revision * (August 2021) to Revision A (March 2023) Page
• Updated the numbering format for tables, figures and cross-references throughout the document............. 3
• Updated Section 1.1.7................................................................................................................................... 4
IMPORTANT NOTICE AND DISCLAIMER

TI provides technical and reliability data (including data sheets), design resources (including reference designs), application or other design advice, web tools, safety information, and other resources “as is” and with all faults, and disclaims all warranties, express and implied, including without limitation any implied warranties of merchantability, fitness for a particular purpose or non-infringement of third party intellectual property rights.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable standards, and any other safety, security, regulatory or other requirements.

These resources are subject to change without notice. TI grants you permission to use these resources only for development of an application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these resources.

TI’s products are provided subject to TI’s Terms of Sale or other applicable terms available either on ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable warranties or warranty disclaimers for TI products.

TI objects to and rejects any additional or different terms you may have proposed.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2023, Texas Instruments Incorporated